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I Changes in Release 2.0.8

Changes in Release 2.0.8

URT Release 2.0.8 contains the following changes:
e Platforms Supported, page 2
e (Clarification about Auto-Install, page 2
e Collecting Troubleshooting Data from the VLAN Policy Server, page 3
e Disabling the URT Event Bus, page 4
e Changes to AdminServerAttributes, page 4
e Support for Netscape 7.0, page 4

Platforms Supported

URT Release 2.0.8 has been tested on the following platforms:

e  Windows 2000 Professional, Server, and Advanced Server running Service
Pack 1, Service Pack 2, and Service Pack 3.

e Windows NT Workstation and Server running Service Pack 6a.

Clarification about Auto-Install

For the auto-install feature to work properly, the PC domain membership must
match the domain of the domain\domain_user logging into the PC.
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Changes in Release 2.0.8 W

Collecting Troubleshooting Data from the VLAN Policy Server

Step 1
Step 2

Step 3

Step 4
Step 5
Step 6

Step 7
Step 8
Step 9
Step 10

Step 11

You can collect data from VLAN Policy Server (VPS) log files and XML files to
provide troubleshooting information to the Cisco Technical Assistance Center
(TAC). The log files (UrtVmpsServer.log) and XML files reside in the
/opt/CSCOpx/objects/urt/data directory on the VPS.

Open a browser window.

Enter the following URL in the address field:
http://VPS_address:1741
where VPS _address is the IP address of the active VPS.

In the CiscoWorks2000 Login Manager window, enter admin in both the
Username and Password fields.

Under the Diagnostics tab, click URT Debugging.

At the bottom of the window, click Enable Debug Trace Mode.
In the URT Debugging window, click Confirm.

The following message is displayed:

URT VPS Server has been restarted and debug trace mode is now enabled.

Under the Diagnostics tab, click URT Debugging again.
To download the .tgz file, click the Download URT Debug Information link.
In the next dialog box, select Save to Disk.

In the Save As... dialog box, navigate to the location in which you wish to save
the debug file.

Click Save.

The diagnostic information is saved (in compressed format) to the location you
specified in Step 10. You can send this file to the Cisco TAC for troubleshooting
assistance.
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I Changes in Release 2.0.8

Step 12

Step 13
Step 14

To disable trace on the VPS, select URT VPS Servers from the URT
Administrative interface.

Double-click the appropriate VPS.

In the URT VPS Server Configuration window, deselect the Enable Trace setting.

Disabling the URT Event Bus

In the Options dialog box of the Administrative tab, the Disable URT Event Bus
feature allows you to disable the TIBCO event bus to suppress the display of
exception messages during client logon and logoff.

Changes to AdminServerAttributes

Three of the administrative options previously saved in UrtOptions.xml are now
saved in UrtAttributes.xml.

These options, available from the URT Administrative interface by selecting
View >Options, then clicking the Admin tab, are:

¢ Enabling and disabling trace on the Administrative Server.
e The UrtAdminServer.log file location.
¢ The Group Membership setting.

A new administrative option, Disable URT Event Bus, is also saved in
UrtAttributes.xml.

Support for Netscape 7.0

The CiscoWorks front end to the VPS web interface now supports Netscape 7.0;
although Netscape 6.2 is still supported, Netscape 7.0 is recommended.
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Upgrading URT from Release 2.0.7 to Release 2.0.8

As part of the upgrade, you must perform some reconfiguration tasks to activate
URT Release 2.0.8 in the network.

e Upgrading the URT Administrative Server, page 5
e Upgrading the VLAN Policy Server 1100, page 6
e Verifying the VLAN Policy Server 1100 Upgrade, page 7

Upgrading the URT Administrative Server

~

Note

Step 1
Step 2

Step 3
Step 4

Step 5
Step 6

Step 7

Step 8

A single URT Administrative Server is recommended. If more than one URT
Administrative Server is installed, URT will not coordinate logons between the
SErvers.

Log into URT using an account that has local Administrator privileges.
Download the URT Release 2.0.8 upgrade from Cisco.com at the following URL:
http://www.cisco.com/cgi-bin/tablebuild.pl/urt

Extract UrtAdminServer.exe from the UrtAdminServer.zip archive.
Double-click UrtAdminServer.exe, then click OK.

The installation program starts.

In the uninstallation dialog box, select Yes to uninstall.

In the confirmation dialog box, select Yes.

The uninstallation program begins. When uninstallation is complete, a dialog box
opens.

Click OK.
The installation program begins.

In the Welcome window, click Next to continue.

[ oL-3145-01
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M Upgrading URT from Release 2.0.7 to Release 2.0.8

Step9  In the User Information text box, enter the username and the company name.
The installation program displays the destination location.

Step10 To continue, click Next.

Step11  In the URT VPS Port Number dialog box, click Next.

S

Note Do not change the port number that the VPS uses to connect to the URT
Administrative Server. This setting is preconfigured on the server.

Step12 In the Create URT Administrative Services text box, enter the user ID and the
system password. (The user ID must have administrator privileges on this
system.)

The installation program begins copying files to your system.
Step13  To complete the installation, select Yes to reboot.

After you restart the system, the URT Administrative Server begins to run, the
URT Administrative Client Interface is installed, and URT is added to the program
list in the Start>Programs menu.

Upgrading the VLAN Policy Server 1100
~

Note During the upgrade, the VPS will reboot twice.

Step1  From any system on the network that can connect to the VPS, open a web browser,
then download the URT VLAN Policy Server Release 2.0.8 upgrade from
Cisco.com.

Step2  The upgrade image folder opens.
Step3  Double-click autorun.bat.

S

Note A DOS command window opens; do not close this window.
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Step 4

Step 5
Step 6
Step 7
Step 8
Step 9
Step 10

Step 11

Upgrading URT from Release 2.0.7 to Release 2.0.8 W

In the next dialog box, click Select to update VPS appliance.
The Setup dialog box is displayed.

In the Appliance Host field, enter the VPS IP address.

In the Appliance Port field, enter 1741.

In the User name and Password fields, enter admin.

Click Install.

Select the radio button for the URT Releases 2.0.8 upgrade.
Click Install.

The installation process begins.

After installation has completed, you are asked if you wish to upgrade another
VPS.

To upgrade another VPS, select Install next; otherwise, select Cancel to end the
upgrade.

Verifying the VLAN Policy Server 1100 Upgrade

Step 1
Step 2

Step 3

Step 4

Step 5

After upgrading the VPS, you should verify the upgrade.

On the system where you performed the upgrade, open a web browser.

Enter the following address:

http://VPS_IP address:1741/index.html.

CiscoWorks2000 starts.

In the CiscoWorks2000 desktop, enter admin in both the Name and Password
fields.

From the CiscoWorks2000 desktop, select Server Configuration>
Appliance Management > Appliance Status>Software Update History.

To verify that the last installation was successful, review the information in the
Status column.
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I URT Documentation

URT Documentation

~

Note

Although every effort has been made to validate the accuracy of the information
in the printed and electronic documentation, you should also review the User
Registration documentation on Cisco.com for any updates.

The following documents are provided in PDF on your product CD:
e [nstalling the User Registration Tool
e Using the User Registration Tool
e URT Developer’s Guide

S

Note  Adobe Acrobat Reader 4.0 or later is required.

Use these documents to learn how to install and use URT:

e [Installing the User Registration Tool (DOC-7811440=)—Describes how to
plan for URT deployment and install URT. This document, available on the
CD-ROM in PDF format, is named urt_ig.pdf.

e Using the User Registration Tool (DOC-785461=)—Describes how to
configure and use URT, and how to troubleshoot network problems related to
URT. This document, available on the CD-ROM in PDF format, is named
urt_user.pdf.

¢ URT online help—Contains all of the information available in Using the User
Registration Tool. This ensures you have complete information even if you do
not have the manual readily available while using URT.

To access online help, click the Help button while running the URT
Administrative Client Interface.
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Additional Information Online

For information about URT supported devices, refer to the following URL, or
check the documentation on Cisco.com for the correct location:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/fam_prod/us
er_reg/index.htm

Installation Issues

Installing the URT Logon Script

To verify that the correct Client Module version is detected, you must install the
URT Logon Script.

Step 1 Install the URT Administrative Server.
Step2  Start URT.
Step3  From the URT main menu, select Configure>Install URT Logon Script.

The urt.bat file is pushed to all domain controllers and the correct Client Module
version is detected (and updated if required).

Release Notes for Cisco Secure User Registration Tool Release 2.0.8
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I Installation Issues

Installing the VPS 1100 from the VPS Recovery CD

~

Note

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6
Step 7

Use the command-line interface to install the VPS from the VPS Recovery CD.

e In HyperTerminal, you must set the flow control to Xon/Xoff.

¢ You must either insert the recovery CD in the CD-ROM drive or copy the
appropriate files to the PC on which you are working.

Connect to the VPS through the console.
Reboot the VPS.

While the VPS is rebooting, press Esc to switch to configuration mode, then wait
for the VPS to finish rebooting.

From the menu that appears, select Choice 1—Change boot order to Boot Flash,
then select Choice 3—Save Changes and exit.

At the next prompt, enter:

reimage http://192.168.1.150:9851/UrtImages/URT

~

Note  The IP address 192.168.1.150 belongs to the host PC that launches the
autorun.bat file (part of the URT Recovery CD image).

Press Enter.

At the following prompt, enter Yes:

This script will re-initialize the system disk.
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Step8  Enter the IP address information for:
e VPS Server
¢ Subnet Mask
e Default Gateway
e DNS Server

Note e The VPS Server information is only used during this process, but this
information must be valid and located on the local network.

e If you make an error while entering the the IP address and want to erase some
characters, you must press Ctrl, then Backspace. If you press Backspace
only, unwanted characters are entered.

Step9 At the following prompt, enter Yes:
Do you wish to reload and start the install?

The screen continues to refresh during this process. Reimaging is complete when
the system has rebooted.

Release Notes for Cisco Secure User Registration Tool Release 2.0.8
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I IKnown and Resolved Problems

JKnown and Resolved Problems

Step 1
Step 2

Step 3

Known problems (bugs) in URT are graded according to severity level. These
release notes contain descriptions of:

e All severity level 1 or 2 bugs.
¢ Significant severity level 3 bugs.
¢ All customer-found bugs (regardless of severity level).

Table 1 describes the problems known to exist in this release; Table 2 describes
the problems resolved since the last release of URT.

You can search for problems using the Cisco Software Bug Toolkit. To access the
Software Bug Toolkit:

Log into Cisco.com.

Select Service & Support>Technical Support Help—Cisco TAC>
Tool Index.

In the Jump to: links at the top of the page, click the letter S, then select
Software Bug Toolkit.

You can also access the Software Bug Toolkit by entering the following URL in
your web browser:

http://www.cisco.com/cgi-bin/Support/Bugtool/home.pl.
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JKnown and Resolved Problems

Table 1 Known Problems in URT Release 2.0.8
Bug ID
(Severity) Summary Explanation
CSCdw92625 |After performing the recovery This occurs after using the VPS Recovery CD to
(@] process, the Software Update reinstall the URT VPS. When using
Status window erroneously CiscoWorks2000 to check the software update
reports that the URT release is 2.0 |[status, the URT release is erroneously reported to
and not 2.0.8. be release 2.0 and not 2.0.8.
To work around this problem, after adding this
VPS again to the URT Administrative interface,
double-click the VPS IP address to display the
URT VPS Server Configuration window where the
server version is displayed correctly.
CSCdw84858 |Cannot use the NET USE This is a known Novell issue; refer to Novell
3) command to map a drive to a document ID 10024207 on the Novell web site.
Windows NT server from a For Windows 95/98ME Novell Clients, the
Windows 95/98 system. . . . . .
appropriate drive mapping command to include in
a DOS batch file that is run from the NetWare
Server volume is:
MAP [drive_letter:| =server_name\volume\
directory\subdirectory
For Windows NT/2000, the drive mapping
command within the DOS batch file is:
NET USE [drive_letter:]| \\systemname\
sharename\
CSCdw46686 |The clientis not assigned to auser |When using a Cisco Catalyst 1900 (v 9.00.05) or
3) VLAN when using a Catalyst Cisco Catalyst 2820 (v 9.00.05) as an access layer
1900 or 2820 as the access layer |switch, the client is not assigned to a user VLAN.
switch. This occurs when the client system uses any port
from 1 through 9.
The logon user is assigned to a logon VLAN, but
was not assigned to a user VLAN.
This problem has been resolved in Catalyst
Release v 9.00.06.
Release Notes for Cisco Secure User Registration Tool Release 2.0.8
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Table 1

Known Problems in URT Release 2.0.8 (continued)

Bug ID
(Severity)

Summary

Explanation

CSCdw65436
(4)

Event times are not sorted
chronologically in the
Administrative Interface.

When you select View>History>Select All in the
Administrative Interface, the Time Of Event
column displays the times in nonchronological
order.

There is no workaround.

CSCdw67479
(4)

Cannot check the
CiscoWorks2000 Systems Status
information.

When logged on to the CiscoWorks2000 Logon
Manager, selecting Server Configuration>
Application Management >

Software Management>Application Status>
Systems Status results in the following error:

An error was encountered while processing
the request. Information regarding the
error is as follows: Description
java.net.ConnectException: Connection
refused Code 112 Additional Information
Cannot process PerfMon response.

To work around this problem, start the PerfMon
process (which is disabled by default) using the
CiscoWorks2000 interface. This process will run
until the system is restarted. (See also bug ID
CSCdw48789.)

CSCdw67827
(4)

More than one instance of the
Administrative Interface can be
opened.

Multiple instances of the URT Administrative
Interface (as many as the host system memory can
manage) can be opened simultaneously without
triggering a warning message.

To work around this problem, do not open more
than one Administrative Interface at a time.

CSCdw68416
4)

The Administrative Interface
accepts invalid MAC addresses.

The Administrative Interface accepts invalid MAC
addresses.

To work around this problem, you must enter the
MAC address in the format 00-00-00-00-00-00.

Jl _ Release Notes for Cisco Secure User Registration Tool Release 2.0.8

0L-3145-01
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Table 1 Known Problems in URT Release 2.0.8 (continued)

Bug ID
(Severity)

Summary

Explanation

CSCdw79430
(4)

The Group Refresh Order>
Install Script dialog box is
misleading.

The installation script dialog box displayed when
you select a specific Windows Domain Controller
(DC) in the same domain states that the URT
Logon Script (URT.bat) is installed on the DC you
have selected. The script is also installed on all
selected DC peers in the same domain.

The install script should state:

The Logon Script will be installed on
[domain_controller_name] and all of its
domain peers.

CSCdw81489
3)

UrtVmpsServerAttributes.xml
should be written to a subfolder.

In the VPS Servers data directory,
UrtVmpsServerAttributes.xml is a critical file; if it
is removed, the VPS cannot receive updated data
files from the Administrative Server.

To recover, you must remove, then add the IP
address of the VPS again within the

URT Administrative Interface>URT VPS
folder.

CSCdx60072
3)

Switch sends out an incorrect

VQP message when using a hub.

When a client is connected to a hub, the switch
caches the client information (the switch port to
which the hub is connected):

1. The client is moved to another switch in the
same VTP domain.

2. The VQP update is sent by the first switch; the
VPS responds as if the user is on both switch
ports.

3. Theuseris moved to the logon VLAN, and the
history log shows the client on both the new
port and the hub port.

There is no workaround.

[ oL-3145-01
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Table 1 Known Problems in URT Release 2.0.8 (continued)

Bug ID
(Severity)

Summary

Explanation

CSCdx53561
(2)

The VQP sends trunking port
MAC address requests.

These requests occur when the client system is
connected to a dynamic switch port and another
switch port is set to trunking mode.

The VQP sends a request for two MAC addresses
on the switch port:

e One MAC address is that of the client attached
to the switch port.

e The other MAC address is that of the trunking
port.

The switch behaves as if there are two MAC
addresses on the switch port, causing the client to
be switched back to the logon VLAN.

This behavior has been observed on Cisco Catalyst
2900XL, 2950, and 3500XL switches.

There is no workaround.

CSCin03687
(2)

The VPS goes down when
installing from the
VpsServerRecovery CD.

When installing the VPS Server image using the
web browser from the VPS Recovery CD, the VPS
goes down.

When installing the VPS from the VPS Recovery
CD, you must use the command-line interface
only. (See the “Installing the VPS 1100 from the
VPS Recovery CD” section on page 10.)
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Table 2 Resolved Problems in URT Release 2.0.8

Bug ID
(Severity) Summary Additional Information
CSCdy00232 |Windows 95 client IP address was |To resolve this problem, you must download an
2) not changed dynamically during |updated version of the Microsoft Windows
login and logout. Sockets 2 (Winsock 2.0) run-time components for
Windows 95 from the Microsoft web site:
http://support.microsoft.com/default.aspx?scid=
KB;EN-US;Q177719
Note  This web site is Copyright © 2002,
Microsoft Corporation.
At this location, you can obtain msvert.dll and a
working version of winicpfg (4.10.0.x or later) for
URT.
CSCdy10491 |History Logging by date wrote This problem has been resolved.
3) one event to an earlier file.
CSCdy10901 |XML data files were not The XML data files were not properly
2) synchronized on the VPS. synchronizing on the URT VPS. Some files had
the correct version number but incorrect data;
other XML files had incorrect version numbers.
Therefore, the data was not synchronizing
properly with the URT Administrative Server.
This problem has been resolved.
CSCdyl11117 |Windows 95 and Windows 98 Entering more than 22 VPSs resulted in an error
3) systems only supported 22 VPSs |message.
from the command line. This problem has been resolved.
Release Notes for Cisco Secure User Registration Tool Release 2.0.8
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Table 2 Resolved Problems in URT Release 2.0.8 (continued)
Bug ID
(Severity) Summary Additional Information
CSCdy12691 |Apache Web Server vulnerability. |URT uses the Apache web server for the VPS
2) administrative interface and to upgrade the VPS.
This patch release resolves the security
vulnerability described in:
http://httpd.apache.org/info/security_bulletin_20
020617.txt
Note  This web site is Copyright © The Apache
Software Foundation.
and
http://www.cert.org/advisories/CA-2002-17.html
Note  This web site is Copyright CERT©O
Coordination Center. CERTO is a
registered trademark and service mark of
Carnegie Mellon University.
CSCdy15341 |After a GroupUpdate, user no This problem has been resolved.
3) longer displayed in the
UrtGroupMemberships.
CSCdy25989 |Reconfirm of switch should also | The URT VPS now sets the VMPS Server settings
3 set VMPS Server settings. before issuing the SNMP reconfirm.
CSCdy27258 |TibrvException error displayed This problem has been resolved.
3 during client logon and logoff.
CSCdy33847 |Could not add task item to Users were not being switched from the logon
3) ClientScheduler queue because VLAN to the user VLAN.
the queue limit had been reached. This problem has been resolved.
CSCdy37123 |Javaexception when loading users |When double-clicking a domain, a Java exception
3 for a domain. displayed in the DOS window; the error was
captured in a log file.
This problem has been resolved.
CSCdy38114 |Client sent out 300 ping packets to |The ping interval has been significantly
3 verify that the link was up. shortened.
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JKnown and Resolved Problems

Table 2 Resolved Problems in URT Release 2.0.8 (continued)

Bug ID
(Severity)

Summary

Additional Information

CSCdy47395
(2)

Space embedded in the system
variable was not recognized.

On some clients, the % TEMP% system variable is
defined as:

C:\DOCUME~1\ADMINI~1\LOCAL SETTINGS\Temp

The space between LOCAL and SETTINGS
caused the remainder of the command to be
truncated.

The URT.BAT script has been changed so that all
occurrences of the % TEMP% variable are
enclosed in quotation marks, as in the following
example:

“$TEMP%$\OnOf fHandler” -domain domain_name

-trace -logoffDelay 7 -exec
“v:\posturt.bat”

CSCdy49007
(4)

URT client file system needed
domain access rights.

If the client file system is locked, the domain
controller, which requires write access to the files,
cannot update the client files upon logon. In these
situations:

e The client remains in the logon VLAN.

e Each client must be manually updated by an
admin user with the appropriate rights (a
prohibitively time-consuming solution in
environments with a large number of PCs).

e A “Permission Denied” error message is
generated.

To work around this problem, you must grant
Domain Controller rights to the client.

[ oL-3145-01
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Table 2 Resolved Problems in URT Release 2.0.8 (continued)

Bug ID
(Severity)

Summary

Additional Information

CSCdy50233
(5)

Need more information about

resynchronizing mobile clients.

URT allows a client to disconnect from one port
and move to another port without logging off. If
users disconnect their systems by unplugging a
cable, logoff takes approximately 10 minutes (the
time it takes for two synchronizing messages to be
generated).

When connecting to a new port, it takes the VPS
approximately 4 to 5 minutes to reinitialize the
client on the new port.

To work around this problem, log off, then logon
again.

CSCdy50527
3)

No online help associated with
Disable Event Bus feature.

At the bottom of the Customize>Options>
Administrative window is a check box to enable
or disable the “Disable URT Event Bus feature.”
If you click Help, no help topic is available.

The following information should be associated
with the Help button:

“Use this option to enable or disable the TIBCO
event bus.”

CSCdy61171
(2)

Auto-install failed on some
Windows clients.

This problem has been resolved.
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Obtaining Documentation

These sections explain how to obtain documentation from Cisco Systems.

World Wide Web

You can access the most current Cisco documentation on the World Wide Web at
this URL:

http://www.cisco.com
Translated documentation is available at this URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM

Cisco documentation and additional literature are available in a Cisco
Documentation CD-ROM package, which is shipped with your product. The
Documentation CD-ROM is updated monthly and may be more current than
printed documentation. The CD-ROM package is available as a single unit or
through an annual subscription.

Ordering Documentation

You can order Cisco documentation in these ways:

e Registered Cisco.com users (Cisco direct customers) can order Cisco product
documentation from the Networking Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl

e Registered Cisco.com users can order the Documentation CD-ROM through
the online Subscription Store:

http://www.cisco.com/go/subscription

¢ Nonregistered Cisco.com users can order documentation through a local
account representative by calling Cisco Systems Corporate Headquarters
(California, U.S.A.) at 408 526-7208 or, elsewhere in North America, by
calling 800 553-NETS (6387).

Release Notes for Cisco Secure User Registration Tool Release 2.0.8
[ oL-3145-01 .m



http://www.cisco.com
http://www.cisco.com/public/countries_languages.shtml
http://www.cisco.com/cgi-bin/order/order_root.pl
http://www.cisco.com/go/subscription

I Obtaining Technical Assistance

Documentation Feedback

You can submit comments electronically on Cisco.com. In the Cisco
Documentation home page, click the Fax or Email option in the “Leave
Feedback” section at the bottom of the page.

You can e-mail your comments to bug-doc @cisco.com.

You can submit your comments by mail by using the response card behind the
front cover of your document or by writing to the following address:

Cisco Systems

Attn: Document Resource Connection
170 West Tasman Drive

San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance

Cisco.com

Cisco provides Cisco.com as a starting point for all technical assistance.
Customers and partners can obtain online documentation, troubleshooting tips,
and sample configurations from online tools by using the Cisco Technical
Assistance Center (TAC) Web Site. Cisco.com registered users have complete
access to the technical support resources on the Cisco TAC Web Site.

Cisco.com is the foundation of a suite of interactive, networked services that
provides immediate, open access to Cisco information, networking solutions,
services, programs, and resources at any time, from anywhere in the world.

Cisco.com is a highly integrated Internet application and a powerful, easy-to-use
tool that provides a broad range of features and services to help you with these
tasks:

¢ Streamline business processes and improve productivity
e Resolve technical issues with online support

e Download and test software packages
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e Order Cisco learning materials and merchandise
e Register for online skill assessment, training, and certification programs

If you want to obtain customized information and service, you can self-register on
Cisco.com. To access Cisco.com, go to this URL:

http://www.cisco.com

Technical Assistance Center

The Cisco Technical Assistance Center (TAC) is available to all customers who
need technical assistance with a Cisco product, technology, or solution. Two
levels of support are available: the Cisco TAC Web Site and the Cisco TAC
Escalation Center.

Cisco TAC inquiries are categorized according to the urgency of the issue:

e Priority level 4 (P4)—You need information or assistance concerning Cisco
product capabilities, product installation, or basic product configuration.

e Priority level 3 (P3)—Your network performance is degraded. Network
functionality is noticeably impaired, but most business operations continue.

e Priority level 2 (P2)—Your production network is severely degraded,
affecting significant aspects of business operations. No workaround is
available.

e Priority level 1 (P1)—Your production network is down, and a critical impact
to business operations will occur if service is not restored quickly. No
workaround is available.

The Cisco TAC resource that you choose is based on the priority of the problem
and the conditions of service contracts, when applicable.
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Cisco TAC Web Site

You can use the Cisco TAC Web Site to resolve P3 and P4 issues yourself, saving
both cost and time. The site provides around-the-clock access to online tools,
knowledge bases, and software. To access the Cisco TAC Web Site, go to this
URL:

http://www.cisco.com/tac

All customers, partners, and resellers who have a valid Cisco service contract have
complete access to the technical support resources on the Cisco TAC Web Site.
The Cisco TAC Web Site requires a Cisco.com login ID and password. If you have
a valid service contract but do not have a login ID or password, go to this URL to
register:

http://www.cisco.com/register/

If you are a Cisco.com registered user, and you cannot resolve your technical
issues by using the Cisco TAC Web Site, you can open a case online by using the
TAC Case Open tool at this URL:

http://www.cisco.com/tac/caseopen

If you have Internet access, we recommend that you open P3 and P4 cases through
the Cisco TAC Web Site.

Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses priority level 1 or priority level 2
issues. These classifications are assigned when severe network degradation
significantly impacts business operations. When you contact the TAC Escalation
Center with a P1 or P2 problem, a Cisco TAC engineer automatically opens a case.

To obtain a directory of toll-free Cisco TAC telephone numbers for your country,
go to this URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Before calling, please check with your network operations center to determine the
level of Cisco support services to which your company is entitled: for example,
SMARTnet, SMARTnet Onsite, or Network Supported Accounts (NSA). When
you call the center, please have available your service agreement number and your
product serial number.
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This document is to be used in conjunction with the documents listed in the “URT Documentation” section.

Copyright © 2002, Cisco Systems, Inc.
All rights reserved.
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